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Before You Install

Welcome to ProTune, Mercury Interactive’s tool for Tuning in Production 
testing. This guide describes everything you need to know to install 
ProTune. It describes the ProTune package contents, the required system 
configuration, registration and backup procedures, and how to run the 
setup programs.

Before you begin to install ProTune, review the following pre-installation 
procedures.

Checking Your ProTune Package

Make sure that your ProTune package contains the items described below. If 
any items are missing or damaged, contact Mercury Interactive or your local 
distributor.

CD-ROMS

Your ProTune package includes a Windows CD-ROM and a UNIX 
CD-ROM containing the ProTune program and associated files.

Documentation

ProTune is supplied with a set of documentation that describes how to:

install ProTune

create virtual user scripts

use the ProTune Console

analyze the results
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Registering Your Copy of ProTune

Register your copy of ProTune to become a licensed user with all rights and 
privileges. Registered users have access to technical support and information 
on all Mercury Interactive products. You will also be eligible for updates and 
upgrades.

To register your copy of ProTune, fill out the Mercury Interactive Software 
Registration card.

If you are in the USA, fill out the USA Owners portion of the card. Send the 
card to the Sunnyvale, California address printed on the card. No postage is 
necessary.

If you are outside the United States, fill out the Non-USA portion of the 
registration card and send it to the appropriate international address. Affix 
postage to the card before mailing.

Remember to notify Mercury Interactive or your local representative if you 
move to a new address, so that you can continue to receive product 
information and updates.
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Note: You can also register your copy of ProTune on Mercury Interactive’s 
Customer Support site: http://support.mercuryinteractive.com.

Where To Go From Here?

Your ProTune CD-ROMs include all the files that you need to install 
ProTune. Your actual setup procedure will differ depending on the 
environment that you will be testing using ProTune:

If your environment consists of only Windows-based machines (i.e. the 
Console and all the Vusers will run on Windows-based machines), follow 
the setup procedure described in Part I of this guide.

If your environment consists of both Windows-based and UNIX-based 
machines, follow the setup procedures described in Part I and Part II of this 
guide.

If your testing environment is... See

Windows only Part I

Windows and Unix Part I and Part II
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Terminology

Vuser A virtual user—a ProTune-created user that 
emulates a human user.

Load Generator machine The workstation used to host the ProTune 
Vusers.

Console machine The machine used to host the ProTune 
Console.

Vuser Group A collection of Vusers with common 
characteristics, such as the machine on which 
they run, or the client that they use. 

Typographical Conventions

This book uses the following typographical conventions:

1, 2, 3 Bold numbers indicate steps in a procedure.

Bullets indicate options and features.

> The greater than sign separates menu levels (for 
example, File > Open).

Stone Sans The Stone Sans font indicates names of interface 
elements on which you perform actions (for example, 
“Click the Run button.”).

Bold Bold text indicates method or function names

Italics Italic text indicates method or function arguments, file 
names or paths, and book titles.

Arial The Arial font is used for examples and text that is to 
be typed literally.

<> Angle brackets enclose a part of a file path or URL 
address that may vary from user to user (for example, 
<Product installation folder>\bin).

[  ] Square brackets enclose optional arguments.
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{ } Curly brackets indicate that one of the enclosed values 
must be assigned to the current argument.

... In a line of syntax, an ellipsis indicates that more items 
of the same format may be included. 
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Windows Installation
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1
Introducing the ProTune Installation

Your ProTune compact disk includes a setup program that guides you 
through the process of installing ProTune’s components.

You can install the ProTune Console, the virtual user components, or both.

System Requirements

In order to successfully run ProTune, you need the following minimum 
system configuration. 

Requirement
Console with 
Monitors

Virtual Vuser 
Generator Virtual Users

Analysis 
Module 

Computer/ 
Processor 

Pentium 350 MHZ 
or higher 

Pentium 350 
MHZ or higher 

Pentium 1 GHz 
or higher  

Pentium 350 
MHZ or higher 

Operating 
System 

Windows NT® ser-
vice pack 6a
Windows 2000 
including
service packs 2 and 
3
Windows XP Pro-
fessional including
service pack 1

Windows NT® 
service pack 6a
Windows 2000 
including
service packs 2 
and 3
Windows XP 
Professional 
including
service pack 1

Windows NT® 
service pack 6a
Windows 2000 
including
service packs 2 
and 3
Windows XP 
Professional 
including
service pack 1

Windows NT® 
service pack 6a
Windows 2000 
including
service packs 2 
and 3
Windows XP 
Professional 
including
service pack 1
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Note: Refer to http://www.mercuryinteractive.com/products/ProTune/technical/ 
for the most updated installation requirements.

Memory 128 MB or more 128 MB or more At least 1 MB 
RAM for non-
multithreaded 
Vuser or at least 
512 KB multi-
threaded Vuser  

128 MB or 
more 

Swap Space Two times the total 
physical memory 

Two times the 
total physical 
memory 

Two times the 
total physical 
memory 

Two times the 
total physical 
memory 

Screen
Resolution

1024*768 or higher 

Screen
Colors

64K or higher

Free Hard 
Disk Space 

Installation: 
300 MB

Installation: 
300 MB

Installation: 
130 MB

Installation: 
100 MB

Browser IE 5.0 sp2 or higher IE 5.0 sp2 or 
higher

N/A IE 4.x or higher
Netscape 
Navigator 4.x 
or higher

MSXML Version 3
service pack 2

Version 3
service pack 2

Version 3
service pack 2

Version 3
service pack 2

Requirement Console with 
Monitors

Virtual Vuser 
Generator

Virtual Users Analysis 
Module 
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Installing ProTune on Your Computer

You can install the Console, virtual user components, or both. In addition, 
you can choose to install the full ProTune configuration, a load generator 
configuration, or a custom configuration. Choosing custom configuration 
lets you specify which ProTune components to install. 

Installation

Note: You must log on as an NT Administrator when performing an 
installation on Windows NT 4.0 or higher. 

To install ProTune on your computer:

 1 Insert the ProTune CD-ROM into a CD-ROM drive. If you are installing from 
a network drive, connect to that CD-ROM drive.

 2 Click Start, and select Run. 

 3 Type the location that you are installing from, followed by setup.exe. For 
example, if your CD-ROM drive letter is M, type:

 4 The initial ProTune Installation window appears. 

Load Generator installs only the components needed for running virtual 
users to generate load. Use this option for machines that are used only to 
generate load and not to control Vusers.

m:\win32\setup.exe
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MI Listener installs the components needed on the MI Listener machine 
used in running Vusers over a firewall and monitoring over a firewall. For 
more information about working with firewalls, refer to the ProTune Console 
User’s Guide.

Tuner Agent is an application that runs on the host that you want to tune, 
and allows you to tune the host remotely.

Click on ProTune Full Installation.
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 5 The Installshield Wizard begins and displays the software licensing 
agreement. Read the agreement and click Yes to accept it and to display the 
Registration Information dialog box. 

 6 In the Registration Information dialog box, type your name, the name of 
your company, and your ProTune maintenance number. You can find the 
maintenance number in the maintenance pack shipped with ProTune. Click 
Next.
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 7 The Setup Type dialog box displays two setup options.

 8 Select the type of installation that you want.

Typical Installation installs all commonly-used ProTune components, 
including the ProTune Console, Virtual User (including GUI) components, 
and online documentation. Use this option for the main tuning machine.

Custom Installation lets you install all the ProTune components, or select 
the components that you want to install. For details, see “Custom 
Installation Options,” on page 15.
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 9 Click Next to display the License Information

 10 Enter the ProTune license code from your license agreement. If you are 
evaluating ProTune or waiting for a permanent license key, enter the license 
key ‘TEMPORARY’. This will let you use up to 20 topology elements for a 
period of 7 days.

Click Next.

If you have a temporary license, ProTune issues a reminder indicating that 
you have 10 days to evaluate the product. Click OK.
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 11 In the Choose Destination Location dialog box, choose the location where 
you want to install ProTune. To select a different location, click Browse, 
choose a folder, and click OK. 

Click Next.
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 12 In the Select Program Folder dialog box, specify a program folder, or accept 
the default folder, ProTune.

Click Next.
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 13 If you installed ProTune’s online documentation, a message tells you to run 
the Acrobat Reader setup after the ProTune setup is complete. You use the 
Acrobat Reader to view the ProTune online documentation.To install 
Acrobat Reader select 
Start > Programs > ProTune > Documentation > Acrobat Reader Setup.

Note: The Acrobat Reader setup installs the Acrobat 5.05 Reader. If you 
already have this version of the Acrobat Reader installed, it is not necessary 
to run the Acrobat Reader setup. 

 14 Click OK to continue with the setup procedure.

 15 In the User Login Settings dialog box, select a user login setting.

Select one of the following user login settings:

Allow virtual users to run on this machine without user login: ProTune will 
automatically log in to the network from the Load Generator machine, so 



Installing ProTune on Your Computer

13

the virtual users can run without any manual intervention. Enter the 
network domain where the user machine resides, a user name, and 
password. Note that you must have administrator privileges.

Note: You must boot and log in to the system at least once after ProTune 
installation before the automatic login can work.

Manual log in to the Load Generator machine: The user must manually log 
into the network from the Load Generator machine for each session of 
running Vusers.

Click OK.

 16 In the Registration Information dialog box appears, click Next to complete 
the installation.

 17 The setup program prompts you to restart your computer. You can delay 
restarting your computer until a later point.
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Note: The following message may appear the first time you log on after a 
full ProTune installation: "HCL Inetd CPLInquire cpl 8af40c". This message 
relates to the HCL (Hummingbird Communications Ltd.) Inetd service, 
when Inetd is installed as a Windows NT service. Please close the message 
box and continue to start your computer.

The ProTune installation is now complete.

Completing the ProTune Installation Process

To complete the ProTune installation process:

Select Start > Programs > ProTune > Readme to see what’s new in ProTune, 
and any last-minute limitations.

To install the Adobe Acrobat Reader 5.05, select 
Start > Programs > ProTune > Documentation > Acrobat Reader Setup.

If your version of ProTune is supplied with a plug and you have not already 
installed the plug, do so now by inserting it into the parallel port.

To create Vuser scripts for Baan, you need to specify the correct application 
server in the Baan user file:

The user file, u[username], is located under the Baan installation folder in 
bse/lib/user. Add the following line to the beginning of the user file:

std_program:ottstpteststand

This tells ProTune to use the Test Standard Program when recording and 
running Vusers.

To start ProTune, select Start > Programs > ProTune > Console.
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Custom Installation Options

If you choose to perform a Custom installation of ProTune, the setup 
program allows you to select the ProTune components that you want to 
install. You can install the following ProTune components: 

Console: Controls the tuning session. Includes the online performance 
monitors. Install the Console only on the machine that will control the 
Vusers.

Analysis: Graphs and reports for analyzing the performance.

Vuser Generator: ProTune’s tool for creating virtual user (Vuser) scripts, 
through recording. Vuser scripts emulate users without a graphical user 
interface by using direct function calls. 

Load Generator: The components for running virtual users (including 
Windows-based GUI Vusers) to generate load. Note: You must have 
WinRunner installed to run GUI Vusers.

MI Listener Component: Components for the MI Listener machine used in 
running Vusers and monitoring over the firewall. For more information, 
refer to the Using Firewalls chapter of the ProTune Console User’s Guide.

Monitors over FireWall: Components on the agent machine for 
monitoring over the firewall. For more information, refer to the Using 
Firewalls chapter of the ProTune Console User’s Guide.

Online Documentation: All user guides in Acrobat format.
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Clear the check boxes next to the components that you do not want to 
install, and select the check boxes next to the components that you want to 
install. 

Click Next to proceed with the installation process.
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Adding ProTune Components

After you install ProTune, you can run the setup program at any time to add 
ProTune components, such as samples, the Virtual User Generator, or the 
online documentation. 

To add components:

 1 Insert the ProTune CD-ROM into a CD-ROM drive.

 2 Click the Start button, and select Run. 

 3 Type the location that you are installing from, followed by setup.exe. For 
example, if your CD-ROM letter is M, type:

Click OK.

 4 Select ProTune Full Installation on the initial ProTune Installation window.

 5 The Installshield Wizard begins and displays the software licensing 
agreement. Read the agreement and click Yes to accept it. The ProTune setup 
program starts. 

 6 In the Registration Information dialog box, type your name, the name of 
your company, and your ProTune maintenance number. You can find the 
maintenance number in the maintenance pack shipped with ProTune. Click 
Next.

m:\win32\setup.exe
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 7 Click Custom Installation, and then click Next.

Select the ProTune components that you want to add. Clear the check boxes 
next to the options that you do not want to add. Click Next.

 8 The Adding Components process continues through the same steps as the 
initial installation starting from the License Information dialog.

 9 Depending on which components you added, the setup program either 
prompts you to restart your computer or informs you that the setup is 
complete. You can delay restarting the computer until a later time.
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Viewing and Modifying a License

You can modify your license at any time directly from the ProTune interface. 
This chapter describes:

Viewing License Information

Modifying a License

Troubleshooting

Normally, you enter your license code during installation. The setup 
program prompts you for a license code. If you do not have your license 
code at the time of installation, you can use the temporary license by typing 
‘TEMPORARY’ in the license key box. This grants you a 10-day license for 20 
topology elements and 25 Vusers for any type of protocol. Contact Mercury 
Interactive Customer Support to obtain your permanent license key.

This chapter describes how to enter a license code if you did not enter it 
during installation, and how to upgrade an existing license. 

Viewing License Information

You can only view license information from the ProTune Console, not from 
the Virtual User Generator.

To view the current license information:

 1 In the Console, choose Help > About ProTune, and click License Info. The 
License dialog box opens, displaying the license information.
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 2 Scroll through the License Keys box to determine the scope of your current 
license. 

The license is defined for the number of elements in the topology and the 
number of Vusers.

The License Keys box lists all the available license keys. 

The License Key Information box displays the license type and validity for 
the item selected in the License Keys box. Select Summary in the License 
Keys box to view the information for all your license keys. Select a specific 
key to view only the details for that key.

The following types of licenses are available:

Permanent: The license never expires.

Time Limited: The license is limited by a start date and an expiration date.

Temporary: The license is granted for a pre-defined number of days after 
product installation.

Plugged: The license requires a dongle.

The Host ID box displays an ID for a specific machine. To receive a license 
key for a specific machine, contact Mercury Interactive’s Customer Support.
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Modifying a License

You can only modify license information from the ProTune Console, not 
from the Virtual User Generator.

To modify the current license information:

 1 In the Console, choose Help > About ProTune. The About ProTune window 
opens.

 2 Click the New License button. The New ProTune License dialog box opens. 

 3 Enter the new license number exactly as it was given to you. Click OK. If 
your license is limited for a specific amount of time, ProTune issues a 
message accordingly. 

 4 Click OK to close the About ProTune window.
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Troubleshooting 

If you have temporary license key, contact Mercury Interactive Customer 
Support to obtain a permanent license key.

If ProTune does not accept your license key, perform the following checks:

Make sure you typed in the license code exactly as it was given to you. 
Your license code is case sensitive.

If your ProTune license requires that you use a plug when running 
ProTune, and a message is issued stating that a plug is not installed, 
perform the following:

Login as Administrator.

Run <protune_directory>/bin/hinstall.exe/i.

Reboot the machine.

If you receive a “permission denied” error message during Console start-
up, you must grant “Full Control” permission for the Registry's 
HKEY_LOCAL_MACHINE key and in the WINNT folder (folder where 
Windows is installed):

To add Registry permissions: 

 1 Run regedt32 to modify the registry.

 2 Select the HKEY_LOCAL_MACHINE key.

 3 Select Security > Permissions.

 4 Add “Full Control” permission to the user that is running the Console.

 5 Turn on the Replace Permission on the Existing Subkeys flag.

 6 Click OK.



Viewing and Modifying a License

23

To add permissions on an NTFS file system:

 1 Select the <System Drive>:\WinNT folder.

 2 Invoke Properties.

 3 Select the Security tab.

 4 Click Permissions.

 5 Add “Full Control” permission for the user.

 6 Turn on the Replace Permissions on Subdirectories flag.

 7 Click OK.
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Part II

Installing UNIX Load Generators
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5
Introducing the UNIX Installation

You can install ProTune load generators on UNIX computers and use them 
to run virtual users. The UNIX virtual users interact with the ProTune 
Console, installed on a Windows machine. Refer to Part I of this Installation 
Guide for information about installing the ProTune Console on a Windows 
machine. This chapter discusses the installation steps and system 
requirements for the ProTune UNIX Virtual User components. 

UNIX Installation Steps

This guide describes the installation of ProTune load generators on all of the 
supported UNIX platforms. When a section applies only to a specific 
platform, it is explicitly stated. 

The main steps of the installation process are:

Installing the program files

Setting the environment

Once you complete the installation, refer to the additional documentation 
for details on working with ProTune.
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Setting the Environment

Since ProTune virtual users emulate an actual user of your system, the 
environment on the virtual user machine must be configured for the user to 
run correctly. The environment variables are defined in the .cshrc file for 
cshell users, and the .profile file for Bourne and kshell users.

The installation process determines the platform upon which the Vuser is 
running, and prepares a script to modify the .cshrc file for cshell users. 
Bourne and kshell users should manually modify the .profile file. Refer to 
Chapter 8, “Verifying Your Installation” for sample .cshrc and .profile files.

The ProTune installation process helps you set the environment variable to 
indicate the location of the ProTune bin directory and any DLLs used by the 
underlying protocol. This environment variable is called LIBPATH on AIX, 
SHLIB_PATH on HP/UX, and LD_LIBRARY_PATH on Solaris and Linux.

System Requirements

Your actual memory requirements may vary, depending on your 
configuration. Note that the installation procedure uses additional memory 
which becomes free after the installation. To ensure a smooth installation of 
the UNIX components, it is recommended that you make sure there is 
sufficient storage space, process entries, swap space, etc. in the disk partition 
where you intend to install the ProTune load generator.

The following table describes the system requirements for each platform 
supported by Mercury Interactive for ProTune UNIX Vusers. 

Note that ProTune supports all X Servers. 

Platform Hardware Version

Solaris Ultra Sparc Solaris 2.8 or higher

HP HP 9000 series 700, 800, HP-UX 11.x or higher

IBM IBM RS/6000 AIX 4.3.3 or higher

Linux PC i486 Red Hat 7.3
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Note: Refer to http://www.mercuryinteractive.com/products/protune/technical/ 
for the most updated installation requirements.

System Resources

The following describes the system resources required for each platform or 
operating system. The actual resources may vary depending on the number 
of Vuser licenses purchased. 

The resources for Vusers listed below apply to each virtual user. If you want 
to use the load generator to run multiple virtual users, you must multiply 
the figure by the number of virtual users. 

The Memory Space above describes a general C-Vuser type. Other types 
may take up more memory space. For example, each Web Vuser uses at least 
500 KB.

Disk Space
required for program installation

22 MB (34 for Linux)

Memory Space
each Vuser if run as thread

300 KB (at least). This amount may vary, 
depending on the operating system and 
platform, and does not include the 
memory used by the process.

Memory Space
each Vuser if run as process

1.5 MB (2.5 MB for Solaris)

Swap Space approximately 1:7 memory/swap ration

Free Process Entries
each Vuser if run as process

1

File Descriptors
each Vuser if run as thread

2 (see below)
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A Load Generator additionally uses the following File Descriptor resources:

14 file descriptors for the ProTune launch service

20 file descriptors for the ProTune agent

30 file descriptors for each Vuser driver. By default, there is a driver for every 
50 Vusers.

For example, to compute the number of file descriptors used in running 100 
threaded Vusers the Load Generator requires:

Total: 294 File Descriptors

If Vusers are run as processes instead of threads, one driver is run per Vuser. 
Therefore, each Vuser requires 30 file descriptors.

You can increase the number of file descriptors, process entries, and amount 
of swap space by configuring the kernel, as described in this chapter.

Note: Most operating systems using ProTune 1.5 or higher have sufficient 
default file descriptors, process entries, and swap space, and rarely require 
reconfiguration.

14 for ProTune launcher

20 for ProTune agent

60 for 2 drivers (30 x 2, each one drives 50 Vusers)

200 for 100 Vusers (each Vuser requires 2)
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Increasing Process Entries 

Each Vuser requires several free process entries. To increase the number of 
process entries on your system, you must reconfigure the kernel. 

Solaris 2.6

The following section describes how to reconfigure the kernel for Solaris 
operating systems.

 1 Locate the /etc/system file.

 2 Set the maximum number of processes in the system file. Type:

 3 Execute the touch/reconfigure command. Type:

 4 Reboot the machine. 

HP-UX

The following section describes how to reconfigure the kernel for HP 
platforms.

 1 Login as root.

 2 Invoke the sam tool to reconfigure the kernel. Type:

 3 Select Kernel Configuration>Configurable Parameters. 

 4 Set the following parameters to the desired values:

nproc: The number of simultaneous processes—(# of Vusers * 2) + 200
maxuser: The number of maximum users—DB + RTE Vusers + 20
maxuprc: The number of processes per user—# of Vusers * 2

 5 Reboot the machine.

set max_nprocs=number (e.g.712)

touch /reconfigure

sam &
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IBM

The following section describes how to reconfigure the kernel for IBM 
platforms using the AIX operating system.

 1 Display the current settings. Type:

 2 Increase the maximum number of process entries per user. Type:

 3 Set the nproc, maxusers parameters to the desired values.

Linux

The following section describes how to reconfigure the kernel for Linux 
platforms.

 1 Locate the /etc/security/limits.conf file.

 2 Set the maximum number of processes in the limits file. Type:

 3 Reboot the machine.

Increasing File Descriptors

Each Vuser requires from 6 (non-GUI Vusers) to 27 (GUI Vusers) file 
descriptor entries. The procedure to increase the number of file descriptors 
differs between platforms and shells. 

lsattr -EHl sys0

chdev -l sys0 -a maxuprocs = number (e.g.500)

hard nproc 8192
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All Platforms

In these examples, the number of descriptors is increased to the maximum 
of 1024.

 1 For sh and ksh users, type:

 2 For csh users type:

Solaris

The following section describes some alternate procedures to increase file 
descriptors on Solaris operating systems. In these examples, the number of 
descriptors is increased to the maximum of 1024. 

 1 Use the adb command to increase file descriptors (all shells). Note that 400 
HEX is the equivalent to decimal 1024. In the following example, kernel is 
the name of the kernel file, e.g., kernel/unix.

 2 You can also increase the maximum number of file processes by 
reconfiguring the kernel. 

Login as root and set the rlim_fd_max parameter inside the /etc/system file by 
typing:

set rlim_fd_max=1024

Save the file and reconfigure the system by typing:

touch /reconfigure. 

After reconfiguring the system, reboot the machine.

ulimit -n 1024

limit descriptors 1024

adb -w -k /kernel/dev/mem
rlimits+28?W 400
rlimits+28/W 400



ProTune Installation Guide • UNIX Installation

34

HP-UX

The following section describes how to increase file descriptors for HP 
platforms.

 1 Login as root.

 2 Invoke the sam tool to reconfigure the kernel. Type:

 3 Select Kernel Configuration > Configurable Parameters. 

 4 Set the maxfiles parameters to the desired values. This is the equivalent to 
file descriptors on Sun platforms. 

maxfiles: The number of files open at a given time, typically set to 60. 
Change it to 500 -1024. 

 5 Reboot the machine.

Linux

The following section describes some alternate procedures to increase file 
descriptors on Linux operating systems. In these examples, the number of 
descriptors is increased to the maximum of 8192. 

 1 Add the following line to the /etc/security/limits.conf file:

 2 Add the following line to the /etc/sysctl.comf file.

 3 Reboot the machine.

sam &

hard nfile 8192

fs.file-max = 8192
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Increasing Swap Space

Each Vuser requires swap space ranging from 200 KB to 4 MB. Before adding 
space to your system configuration, you should determine your paging 
requirements. For environments running programs with very large memory 
requirements, it is recommended to have paging space of four times the 
physical memory. If you do not have enough paging space, certain processes 
may be killed, and others will be unable to start.

Solaris

The following section describes how to increase swap space for machines 
running Solaris.

 1 List the available paging areas. Type:

 2 Display the available swap space. Type: 

 3 Create a new paging file. Type:

 4 Add the page file to the existing configuration. Type:

 5 Enable all swap areas listed in the filesystem configuration. Type:

swap -l

swap -s

mkfile size  path (e.g. mkfile 50m /extra/page_1)

/usr/etc/swapon -a /extra/page_1 0 102400

/usr/etc/swapon -a 
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IBM

The following section describes how to increase swap space for machines 
running the AIX Operating System.

 1 List the available paging areas. Type:

 2 Display the available swap space. Type: 

 3 Create a new paging file, using a value one quarter the size of the actual file 
size. For example, to create 200 MB of paging space in the chemvg volume 
group, type:

 4 To increase the size of an existing paging file, type:

(e.g chps -s 10 page_01 adds 40 MB to page_01).

 5 Add the page file to the existing configuration. Type:

 6 Enable all swap areas listed in the file system configuration file 
/etc/swapspaces. Type:

lsps -a

swap -s

mkps -a -n -s 50 chemvg

chps -s number paging_file

swapon paging_area (e.g. swapon /dev/paging_01)

swapon -a 
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6
Installing Load Generators on UNIX

ProTune is installed using the installation media provided with the ProTune 
distribution package. The installation uses a Java Runtime Environment 
(JRE).

The following sections describe installing the ProTune UNIX components 
from a UNIX CD-ROM device. If a UNIX machine with a CD-ROM device is 
not available, you can copy the UNIX components from the CD into a 
directory on your PC, and transfer them to a UNIX directory via ftp or an 
NFS mounting at a later stage.

Checking your Environment

Verify that a CD-ROM device is attached to your local or remote machine. 

Find out which device driver is available for use with this drive. The device 
driver is usually located in the /dev directory of the machine to which the 
drive is attached. Consult your system administrator for the name of your 
device. 
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Installing Load Generators on Multiple Platforms

In order to run ProTune load generators on multiple UNIX platforms, you 
need to install a separate version of the ProTune load generators, in a 
separate directory, for each platform. The installation directories must be 
accessible to all the platforms. At the end of installation, follow the 
instructions at the end of this chapter for modifying the environment 
variables to indicate the ProTune installation directories.

For example, in order to install ProTune load generators on a site that has 
both Solaris and IBM machines, you could use the following directories:

For ProTune Solaris: /tools/mercury/sol/protune

For ProTune IBM: /tools/mercury/ibm/protune

If you intend to run multi-platform session steps, both directories should be 
NFS mounted. The Solaris machine should access the IBM installation 
directory and vice versa.

Running the Installation Program

Before you begin the installation program, make sure you see the install 
script, install.sh from the CD. Note that most operating systems require you 
to mount the CD-ROM drive to a local directory. For information for 
mounting a CD-ROM on IBM, see “Preparing to Install from a CD-ROM 
(IBM only)” on page 43.

There are two installation modes, UI (or AWT) mode and console mode. 

To run the installation in UI mode, make sure that the DISPLAY 
environment variable is properly configured.

To run the installation in console mode, add the -console parameter to the 
command line. For example:

install.sh -console
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To run the ProTune installation program:

Note: The instructions below are for the UI mode.

 1 Type:

install.sh

The installation program begins and displays the license agreement.
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 2 Read the agreement and select the option to accept it. The ProTune 
installation program begins and displays the installation location dialog 
box.

Choose the location where you want to install ProTune. To select a different 
location, click Browse, choose a directory, and click OK.

Click Next.
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 3 A read-only dialog box with your installation settings appears. 

To select different installation settings, click Back. To begin installation, 
click Next. The installation process begins.

 4 At the end of the installation, a message appears about setting the ProTune 
environment variables. The next step outlines this procedure. First complete 
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the automatic installation by clicking Next, and then clicking Finish in the 
screen that follows this message. 

 5 The installation process prepared a file called env.sh that contains 
environment variable definitions for your cshell environment. Open the 
.cshrc file for each ProTune user and add the following statement:

source /opt/ProTune/env.sh

where /opt/ProTune is the ProTune installation directory.

Bourne shell and kshell users should refer to Chapter 7, “Post Installation” 
for instruction on modifying the .profile file.

 6 Bring up a new terminal to run the .cshrc file. For more information about 
.cshrc files, see Chapter 7, “Post Installation.”

 7 Be sure to run verify_generator to verify your Vuser installation. This is a 
confirmation step, to ensure that the specified directory and device name 
are correct, and that you have sufficient disk space. For information about 
the tests performed by verify_generator, see Chapter 8, “Verifying Your 
Installation.”
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Preparing to Install from a CD-ROM (IBM only)

When installing ProTune load generators on an IBM platform, you must 
mount the CD-ROM drive to access the installation program.

To mount the CD-ROM drive:

 1 Insert the CD-ROM into the drive and log in or su as root.

 2 Create the ProTune installation directory by typing:

 3 To add a CD-ROM file system, you need to use SMIT. To enter the program, 
type:

 4 From within SMIT, select File Systems.

 5 Select Add/Change/Show/Delete File Systems.

 6 Select CD ROM File Systems.

 7 Select Add a CDROM File System.

 8 Choose a DEVICE name. Note that device names for CD-ROM file systems 
must be unique.

 9 Type in the following MOUNT POINT:

 10 Select the Do command, or click enter if you are using the ASCII interface.

 11 Quit the SMIT program.

 12 Type the following command in order to mount the CD-ROM file system:

 13 For the FILE SYSTEM Name, select either /dev/cd0 or /dev/cd1.

mkdir -p /usr/cdrom/lrun

smit storage

/usr/cdrom/lrun

smit mountfs
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 14 Select the mount directory:

 15 Select cdrfs to set the TYPE of file system.

 16 Select Yes to mount as a READ-ONLY system. 

 17 Select Do or Enter if you are using the ASCII interface.

 18 Close your connection as the root user.

Running the Uninstall Program

The uninstall program, like the installation program, uses a Java Runtime 
Environment (JRE). You can also run the uninstall program in UI mode, or 
in console mode. To run the program in console mode, add the console 
parameter to the end of the command line.

To run the ProTune uninstall program:

 1 To access the program, type:

cd <installation directory>/_uninst

 2 Type:

uninstall.bin [-console]

/usr/cdrom/lrun
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7
Post Installation

After installing ProTune load generators, prior to starting work, you should 
check that your environment is configured properly. 

This chapter discusses:

Setting Environment Variables

Checking Authorizations

Sample .cshrc and .profile Files

After you complete the post-installation configurations, run the ProTune 
verification utility to check your installation. For more information, see 
Chapter 8, “Verifying Your Installation.”

Setting Environment Variables

The ProTune installation procedure created a file, env.sh which sets the 
environment variables. Rather than manually updating your .cshrc file with 
the variable definitions, you include a statement to access env.sh at the end 
of the .cshrc file. This section describes the environment variables in your 
env.sh file. Note that if you are working with kshell or Bourne shell, you 
should manually set these variables in your .profile file. The syntax in the 
examples below are for cshell users. For kshell and Bourne shell users, see 
“ProTune Settings in the .profile File” on page 48.

M_LROOT

PATH

LD_LIBRARY_PATH (Solaris, Linux), LIBPATH (AIX), SHLIB_PATH (HP-UX)
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M_LROOT: Set M_LROOT to the ProTune installation directory. For 
example:

PATH: The location of ProTune’s executable programs, the bin directory, 
must be added to the PATH variable. 

LD_LIBRARY_PATH: The path should include the location of ProTune’s 
dynamic libraries ($M_LROOT/bin). To set the path, type: 

Check the dynamic libraries used by your application, and make sure that 
their path is also included in the appropriate dynamic library path 
environment variable (LD_LIBRARY_PATH, SHLIB_PATH or LIBPATH).

To check the dynamic libraries used by your application, type:

Note: Remember that in order to use Oracle73, you need to add the path 
Oracle73 libraries to the dynamic libraries path environment variable.

setenv M_LROOT /tools/protune

set path = ($path $M_LROOT/bin)

setenv LD_LIBRARY_PATH ${LD_LIBRARY_PATH}:$M_LROOT/bin 
/*Solaris and Linux*/

setenv SHLIB_PATH ${SHLIB_PATH}:$M_LROOT/bin/*HP Platforms */
setenv LIBPATH “${LIBPATH}:$M_LROOT/bin” /*IBM Platforms */

ldd my_application  /* Sun and Linux platforms */
chatr my_application  /* HP platforms */
dump -H my_application  /* IBM platforms */
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Checking Authorizations

In order to execute Vusers on remote hosts, you must be authorized to 
execute a remote shell. To check your permissions on a host, type:

For Solaris, Linux and IBM platforms:

For HP platform: 

If you do not have permission, consult the .rhosts file (man rsh or remsh).

Sample .cshrc and .profile Files

ProTune Settings in the .cshrc File

The following is an example of ProTune settings within a user’s .cshrc file:

# ProTune settings #
#Chooses a path based on the location of the machine dependent ProTune 
installation

switch ("‘uname‘")
case SunOS:

setenv M_LROOT {replace with ProTune Solaris installation path}
setenv LD_LIBRARY_PATH ${LD_LIBRARY_PATH}:${M_LROOT}/bin

breaksw

    case HP-UX:
setenv M_LROOT {replace with ProTune HP-UX installation path}
setenv SHLIB_PATH ${M_LROOT}/bin ${SHLIB_PATH}

breaksw

rsh hostname ls

remsh hostname ls
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case Linux:
setenv M_LROOT {replace with ProTune SunOs installation path}

    setenv LD_LIBRARY_PATH ${LD_LIBRARY_PATH}:${M_LROOT}/bin
breaksw

case AIX:
       setenv M_LROOT {replace with ProTune AIX installation path}

setenv LIBPATH ${M_LROOT}/bin:${LIBPATH}
       breaksw
endsw

set path = ($M_LROOT/bin $path)

# End ProTune setting #

ProTune Settings in the .profile File

The following is an example of ProTune settings within a user’s .profile file 
for kshell and Bourne shell environments:

# ProTune settings #
#Chooses a path based on the location of the machine dependent ProTune 
installation

case "‘uname‘" in
SunOS)
 M_LROOT={replace w/ ProTune Solaris installation path} ; export M_LROOT
   LD_LIBRARY_PATH=${M_LROOT}/bin ; export LD_LIBRARY_PATH
;;

HP-UX)
    M_LROOT={replace w/ LR HP-UX installation path} ; export M_LROOT
    SHLIB_PATH={${M_LROOT}/bin ; export SHLIB_PATH
;;
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AIX)
    M_LROOT={replace w/ ProTune AIX installation path} ; export M_LROOT
    LIBPATH=${M_LROOT}/bin ; export LIBPATH
;;

Linux)
    M_LROOT={replace w/ ProTune Linux installation path} ; export 

M_LROOT
    LD_LIBRARY_PATH=${M_LROOT}/bin; export LD_LIBRARY_PATH

esac

PATH=${M_LROOT}/bin:${PATH}; export PATH

# End ProTune setting #
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8
Verifying Your Installation

ProTune has a setup verification utility verify_generator, that checks the 
ProTune setup. It checks environment variables and your .cshrc file to verify 
that they are set up correctly. The verify_generator utility checks the remote 
Vuser hosts. 

It is strongly recommended that you run verify_generator after a Vuser 
installation, before attempting to invoke ProTune. 

The verify_generator Test

The utility checks the following items in the Vuser environment: 

at least 128 file descriptors

proper .rhost permissions: -rw-r--r--

the host can be contacted using rsh to the host. If not, checks for the host 
name in .rhosts 

M_LROOT is defined

.cshrc defines the correct M_LROOT

.cshrc exists in the home directory

the current user is the owner of the .cshrc 

a ProTune installation does exist in $M_LROOT

the executables have executable permissions

PATH contains $M_LROOT/bin, and /usr/bin

the rstatd daemon exists and is running
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verify_generator Option

The verify utility checks the local host for its communication parameters 
and its compatibility with all types of Vusers. If you intend to run all of the 
Vusers on one host, type: 

verify_generator either returns ‘OK’ when the setting is correct, or ‘Failed’ and 
a suggestion on how to correct the setup.

The syntax of verify_generator is as follows:

verify_generator [-v]

-v
Provides detailed information about the checks.

verify_generator
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